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ABSTRACT 

 

Augmented reality (AR) is the overlaying of digitally-created content such as 

computer-generated graphics, videos, texts and sounds are layered on top of a 

physical view. Augmented reality permits the users to have interaction with real and 

virtual elements or augmentation. Whereas Virtual reality (VR) is computer generated 

stereo visuals which replace the actual world surroundings of a consumer around 

them. Both Augmented and Virtual reality may be supplied to consumers through 

headsets like HTC Vive, Oculus Rift, and Microsoft’s HoloLens or through the 

camera of a mobile phone. In both practical and experimental implementations, 

augmented reality and virtual reality can replace or lessen the consumer’s belief of 

truth.   

 

Augmented and Virtual reality has been adopted in various industries such as retail, 

healthcare, science educational and real estate. Some agencies accept already 

fabricated use of this avant-garde technology in several ways, from auspicious their 

book catalogs to alternate demonstrations at accession and on an adaptable screen. 

That is why I choose augmented reality and virtual reality in real estate visualization 

to give the clients more informative and visual proposal and for the agencies 

who touch upon buyers that have a clearer vision on an attainable deal. 

 

I start Realview: AR for Real estate from the AutoCAD master plan layout, complete 

the model using by AutoCAD, 3Ds Max, Adobe Photoshop plays a role texturing 

whole project and Unity game engine for Virtual reality and Augmented reality. In 

this project, we can discover an outline architectural visualization of actual estate 

buildings that customers are shopping for with the view of what they're buying, in 

augmented and virtual reality.  
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CHAPTER 1 

INTRODUCTION 

 

1.1 Background 

The first ever Augmented reality app was created in 1968 by father of computer 

graphics “Ivan Sutherland” [1]. It turned into an AR head-installed display gadget. 

From then on AR superior as wearables and digital shows. It could format virtual 

factors at the actual-international photo, as an instance, show geological information 

approximately about a selected area.  In the year 2008, Augmented reality has opened 

a way of using augmented reality in industrial purpose. A Garman agency developed 

an augmented reality application for BMW Mini. To enable it a customer had to point 

a camera at a printed ad and the model of car auto come alive at the display. The 

customer could manipulate car on the screen by controlling it and move it around to 

view at different angles, simply by manipulating the printed image. 

In the early 2010s Augmented reality introduced that might have interaction with 

actions in the real world in real time. For that reason, the virtual try on technology has 

all started by augmented reality’s instant face recognition revolutionized buying 

experience. Now you can try out anything form virtual making up your face to place a 

couch inside your home. 

In 2016, augmented reality (AR) catapulted into the mainstream with the release of 

Pokemon Go [2], an AR game that grew to 45 million daily active users after just two 

months on the market. Since then AR has been adopted in various industries. 

Let’s take a look at what augmented reality is, the benefits of augmented reality. 

Augmented reality [3] can be described in somewhere between physical world and 

virtual world where computer generated images, texts, sounds, animations, videos are 

layered on the top of the physical view. Users can interact with these elements via 
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application on smartphones, tablets, augmented reality headsets like Microsoft 

HoloLens [4], and augmented reality glasses like Vuzix Blade [5]. 

Benefits of Augmented Reality: 

One of the significant benefits of augmented reality is it can visualize information in 

3D rather than 2D. As an Example, for an architecture planning, drawings and 

renderings are usually presented in a flat and 2D format, However, with Augmented 

reality those viewing plans can be shown as 3D format where walking around the 

model, look at every angle of the future building can build its own opinions about its 

design.  

Another important benefit of augmented reality is it can not only make complex data 

easier to understand but also create an interactive experience that is intuitive, 

meaningful and also memorable to the users. 

In addition, augmented reality can create personalized product experience, generating 

buzz, establishing repeat engagements of customers. Think about giving trials of 

cloths without even putting them on or furnishing interior with furniture’s without 

moving or buying them. Also, we can look into Pepsi bus shelter advertisement [6], 

for using augmented reality in real life. 

Benefits of Virtual Reality: 

Virtual reality (VR) [7] is an interactive computer-generated revel in taking place 

inside simulated surroundings. It contains particularly auditory and visible comments, 

but might also allow different kinds of sensory remarks. These immersive 

surroundings can be just like the actual global or it is able to be fantastical. present 

day VR technology maximum typically uses virtual fact headsets or multi-projected 

environments, from time to time in aggregate with physical environments or props, to 

generate realistic snap shots, sounds and different sensations that simulate a 

consumer's physical presence in a virtual or imaginary environment. a person the 

usage of digital reality gadget is able to "look around" the artificial international, flow 

around in it, and have interaction with virtual functions or gadgets. The impact is 

normally created through VR headsets along with a head-mounted show with a small 

display in front of the eyes, but can also be created via mainly designed rooms with a 
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couple of huge monitors. other styles of VR encompass augmented truth and mixed 

reality structures. 

Generally, an actual property agent gives a long listing of residences to the customer. 

later on, come the explanations, negotiations, and ultimately the actual-existence 

visits to homes and residences. This workflow has remained the equal for decades, but 

in fact it's inconvenient and time-eating no longer only for realtors however for 

homebuyers as properly. 

1.2Motivation 

According to various studies, Augmented Reality (AR) and Virtual Reality (VR) in 

real estates makes customes interested and involved. In general, Augmented Reality 

(AR) and Virtual Reality (VR) is quite fasciniting and enchanting. Augmented and 

Virtual Reality visualization works much better than photos and videos with text 

description.  

Most of the clients who wants to buy real estate properties, before they make the final 

decision of purchase wants to visit the apartments by themselves. Augmented and 

Virtual reality may lower the numbers of the visits and can save time from clients and 

developers. 

I would like to create a Augmented and Virtual reality application for mobile devices 

by which Real estates developers or sellers can show a virtual tour of the apartments 

they are selling to the clients. I wanted to create an application that consists 3 different 

type of bulidings with Exterior and Interior views of the apartments in the building. 

Different types of softweres will be used to create the whole project. 

For modeling the buildings I have used :- Autodesk 3ds Max [8]. 

For Texturing the buildings I have used :- Adobe Photoshop [9]. 

For Creating Augmented and Virtual reality Application I have used :- Unity3d [10]. 

The final Output will be a complete application with 3 buldings Along with their 

Exterior and Interior views. Users can scale and rotate the buidings as they want and 

they will also have First Person View to have a walkthrough inside the apartments if 

they doesn’t have any Virtual Reality device. 
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By completing this project, it will give me more opportunity to show and share whjat 

I have learned till now as a student of Multimedia & Creative Technology department 

of Daffodil International University. This will improve my confidence and skills for 

the job market as well. 

1.3 Objectives 

The objectives of the project are to: 

Make the AutoCAD [11] drawing plans into a 3D architectural visualization.  

Develop 3D models of the AutoCAD plans with Exterior and Interior views. 

Texturing the models to give a better look. 

Making “Realview: AR for real estates” an application with Augmented Reality and 

Virtual Reality along with First person view. 

Getting a better output for my final project. 

The following chapter presents the research of the project including various important 

information about the project. The methodology of the development of 3D models. 

This chapter includes the plans I have been working with to complete the project. 

Explanation of Augmented and Virtual reality works is presented in chapter 4. The 

developing software’s and plugins are discussed with reference in chapter 5. The 

problems that solved based on user experience are discussed in chapter 6.  The 

outcomes and technology uses are discussed in chapter 7. Finally, an overview with 

the conclusion and further works is given in chapter 8 and 9. 
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CHAPTER 2 

RESEARCH 

 

First of all, I will give thanks to my seniors that they have built an Augmented and 

Virtual reality project on the architecture plan of DAFFODIL INTERNATIONAL 

UNIVERSITY of 2040. I was lucky to have the chance to watch closely the project 

they have accomplished. When they were building their project, I had an idea of 

visualizing the AutoCAD maps in a different and more effective. I had learned 

Augmented and Virtual reality developing from a Workshop that was organized by 

our department. I learned how to develop augmented and virtual reality projects on 

that workshop. But I had very limited idea on developing augmented reality and 

virtual reality applications. So, When I had the idea of making an application for Real 

estate developers, I had to do research about how am I going to accomplish this 

application. I discussed my idea with my supervisor and senior students of my 

department. They have helped me with my research and finding solutions for the 

obstacles I will be facing.  

So, before I jump into my creation process, I tried to understand the requirements I 

need to fulfill and how am I should be doing that. I wanted to manage a list of 

software’s and technical needs which are required to build this product.  

Here’s the list I have made: 

● Models 

○ Full building exterior 

○ Interior for Level One     

● Augmented Reality (AR) 

○ Single Tracking 

○ Multi Models  

● Virtual Reality (VR) 

○ 3D Walkthroughs 
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Initially I had the idea of making the features only for augmented and virtual reality 

view. But sometime later while I was discussing the project plan with my supervisor, 

he asked me about what if any user has no Virtual reality device and what if user has 

lost the tracking the image or the wrong tracking image even worse, he doesn’t have 

the tracking image? I got stuck and realized yeah what will happen then? Then I re-

oriented the project plan and made the project plan given below: 

● Models 

○ Full building exterior 

○ Interior 

● Augmented Reality (AR) 

○ Multi Tracking 

○ Multi Models  

● Virtual Reality (VR) 

○ 3D Walkthroughs 

● First Person View (FPS) 

○ 3D Walkthroughs 

● Normal Unity View (Non-AR mode) 

2.1 Models 

Full building exterior: Develop building models in low-poly but with realistic view. 

This help to properly visualized the beauty of that building. 

Interior: By creating interior design it gives that clear vision how arrange the 

furniture. Those are made by lightweight technology. 

2.2 Augmented Reality (AR) 

Multi tracking: Single app for all buildings. Click and scan on your desire building 

and see the magic of AR/VR. 

Multi models: By scanning a single tracker system will bring 2 models. Which are 

1. Full building 

2. Interior 



 

7 

©Daffodil International University 

2.3 Virtual Reality (VR) 

3D Walkthrough: In VR mode use can freely move around the floor. It will give 

him/her the real flavor of being inside that floor. 

2.4 First Person View (FPS) 

3D Walkthrough: In FPS mode use can freely move around the floor. It will give 

him/her the real flavor of being inside that floor. 

2.5 Normal Unity View (Non-AR mode) 

If any user doesn’t have Image Tracker and Virtual reality device then he/she can go 

by the normal unity view mode to see the models. 
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CHAPTER 3 

3D MODEL DEVELOPMENT 

3.1 Introduction 

AutoCAD drawing files are obtained from a Real estate developer company. The 

company have also provided the elevation of the buildings as a reference to get clear 

idea of how the buildings would look like. I have to do Research about how will I 

optimize the buildings for mobile platform. By those researches I have found a way 

that will render my buildings in mobile platform very easily and smoothly in 

Augmented reality and virtual reality. 

3.2Layout 

The Visual Layout apparatus unites detailing components so they can be organized on 

a page and yield in a report by means of the Render device. The Visual Layout 

instrument support non-gathered components as it were. Utilize the Visual Layout 

device to choose a report type, mastermind report components on the page, and 

imagine how the report will look. The Visual Layout instrument acknowledges 

numerous sources of info, gives a review of report components, offers different yield 

types and page sizes, and takes into account both a flat and vertical layout. 

 

Figure 1:This is a reference AutoCAD building layout 
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Importance of Layout 

Define the parameters of a model within available resources and time. 

Focus and organize each of model. 

Great visual layout likewise clearly makes applications more alluring and externally 

satisfying. 

3.3 Layouts of my project 

I have pre-visualized our final project and drawn the following layout so that the 

model measurement can act as a reference in AR and VR. To get those layout I 

looked online for resources and found some Bangladeshi developer companies layout. 

Then I contact with Rajbari Holdings [12]. They have given me 3 of their lauout to 

work with and then I started working with the AutoCAD layouts. 

 

Figure 2: This is 1st reference AutoCAD building layout 
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Figure 3: This is 2nd reference AutoCAD building layout 

 

Figure 4:This is 3rd reference AutoCAD building layout 
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CHAPTER 4 

Workflow 

4.1 Modelling workflow 

Model processing: 3D model to Autodesk3Ds Max software then imported file from 

AutoCAD file. Select line from splines to draw line. Then convert the line into 

editable poly. Then select the faces and extrude the face maintaining the height 

10feet. 

 

Figure 5: This is the workflow of modeling. 
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Then, select the faces and cut out the window and door space according to the 

AutoCAD plan. Then Change standard primitives to doors and select a door for 

making the doors. I have used Pivot door and sliding door. Then place the doors 

according to the plan in the 3d model. Same goes for windows. 

 

Figure 6 : Imported AutoCAD model in 3ds max. 

 

 

Figure 7: Extruded walls from the AutoCAD plan 
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Figure 8:Placing windows and doors in 3ds max 

4.2 Texturing workflow 

Open Material Editor or press CTRL + M (Shortcut key). Change the material mode 

to compact Material mode. Select a Material slate and double click on its diffuse, 

click bitmap to insert an image as a texture map. I have used wooden textures for 

room floor, tiles for kitchen and bathroom floor. I have used multi/sub-object material 

system for the floor texturing. To do this, I pick another material slate and changed its 

mode to standard to multi/sub-object material mode. Then I set the ID’s I needed. I 

picked each material to each id. Then I assigned the material to the floors. I have 

selected each floor and assign material ids to each to get the right material I have set 

for them. After that I have used UVW map modifier to each object to set the texture 

right. 
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Figure 9: This is the workflow of texturing. 
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Figure 10: Assigning material to the objects 

After assigning the materials I have multiplied the floors to create the full exterior 

building. I have grouped all the objects then multiplied it. 

 

Figure 11: The full exterior building 
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4.3 Exporting from 3ds Max to Unity 

To Export from 3ds max to Unity the traditional format of doing Exporting is using 

FBX format that contains all the meshes and textures and camera, lights etc. But for 

this project I have used another way of exporting method that will reduce the model 

size and it will import the models into unity in JSON (JavaScript object Notation) 

format. To Export from 3Ds max I have used an open source plugin called as Babylon 

JS [5]. In Babylon js I have selected the models I want to export and then I exported 

the models. 

 

Figure 12: Exporting from 3ds max using Babylon.js 
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4.4 Unity workflow 

To start working in Unity3D, firstly I need to make unity capable of making 

Augmented and Virtual reality. So, after starting a new project in unity, first of all I 

opened build settings from files. 

Table 1: Unity workflow 

Unity workflow 

Open Unity 

↓ 

Open build settings 

↓ 

Set the platform to Android to Pc, mac & Linux standalone 

↓ 

Open player settings 

↓ 

Go to Resolution & Presentation 

↓ 

Change the orientation to Landscape Left 

↓ 

Go to Other Settings 

↓ 

Change the package name & Set Minimum API level to Android 5.0 (Lollipop) 

↓ 

Go to XR Settings 

↓ 

Check the Virtual Reality Supported checkbox & Set Vuforia 
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In the build settings, by default unity sets itself for PC, mac & Linux standalone 

environment. So, I switch the build mode to Android from PC, mac & Linux 

standalone. 

 

Figure 13: Unity Android Build Settings (A) 
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After switching the platform, I opened player settings and changed the orientation to 

landscape left from resolution & presentation. Then I have opened other settings and 

changed the package name & set the minimum android API level to Android 5.0 

(Lollipop). 

 

Figure 14 : Unity Other Settings (B) 
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Then I opened XR settings and checked the virtual reality supported checkbox & set 

Vuforia for augmented and virtual reality support. Now, my system is fully ready to 

develop augmented and virtual reality application. 

 

Figure 15 : Unity XR Settings 
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After Exporting from 3ds max using Babylon js in glTF [13] (GL Transmission 

Format) I need to import those models into unity. To import glTF models into unity I 

have to use a plugin called UniGLTF [14].  UniGLTF imports the glTF files as a 

prefab in unity. So, I created a folder named prefabs and I imported the models in 

glTF format into unity. 

 

Figure 16 : Importing glTF files into unity using UniGLTF 
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4.5 AR workflow 

To start developing AR project I have to make tracker images first. So, I created 

chessboard background with building images.  

Table 2 : AR workflow 

AR workflow 

 

In AR project, firstly I create 3 images using chessboard background with building 

images 

↓ 

Creating a new database in Vuforia 

↓ 

Upload the images in target manager 

↓ 

Download the Database from Vuforia in Unity package format 

↓ 

Import the database into Unity 

↓ 

From the menu select Game Object>Vuforia> AR Camera 

↓ 

Again, Game object > Vuforia >Image target 

↓ 

Select the image of building 

↓ 

Put the model prefab of the building on top of the image target 
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Then I logged into Vuforia development portal and created a new database for my 

application.  

 

Figure 17 : Vuforia License manager 

 

Figure 18 : Realview Vuforia License 
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Then I went into target manager and uploaded the images. 

 

Figure 19 : Real View Image Target Manager 

After sometime Vuforia analyzed the images and given me ratings for the images.  

 

Figure 20 : Vuforia Image target for realview 
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Figure 21 : Realview Tracker Image 1 
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Figure 22 : Realview Tracker Image 2 

 

 



 

27 

©Daffodil International University 

 

Figure 23 : Realview Tracker Image 3 
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Then I downloaded the database from Vuforia in unity package format. After that I 

imported the database into unity. 

 

Figure 24: Model on image tracker 

4.6 Normal View Workflow 

Create a New Scene  

Import the models as Prefabs.  

Create an empty Game Object 

Assign a script that will switch between Exterior and Interior models with the empty 

Game Object. 

Create Button and assign the Empty Game Object on that. 
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Figure 25: Unity Normal model view 

 

 

Figure 26 :  Model changing script 
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4.7 VR workflow 

For Virtual Reality View I have used Google Cardboard viewer [15]. For Virtual 

reality walking mode, I have to make the models walkable. For that I have to bake 

NavMesh [16] from the model.  

Go to Window > AI > Navigation 

Select the model parts that we want to bake as NavMesh. 

Set the NavMesh Agent height and radius. 

Bake the NavMesh. 

Now the character can walk inside the model. 

Import the Google Cardboard Viewer unity package into unity. 

From Google VR > Prefabs > GvrEditorEmulator 

Assign the GvrEditorEmulator into Hierarchy 

From Google VR > Prefabs > Controller > GvrControllerMain 

Assign the GvrControllerMain into Hierarchy 

From Google VR > Prefabs > EventSystem > GvrEventSystem 

Assign the GvrEventSystem into Hierarchy 

From Google VR > Prefabs > Cardboard > GvrReticlePointer 

Assign the GvrReticlePointer under the main camera as child object. 

As the NavMesh was baked before now the character can walk inside of model. 

Create an Empty Game Object, Name it Player. 

Drag the main camera under the player to make it a child object of player. 

Create an empty game object and name it VR Module. 

Assign a Script that will contain Vr Scene Switching methods in VR Module. 
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Create a button and assign the Vr Module game object into the button. 

Now the VR view will initiate when button clicked. 

 

Figure 27: VR Workflow 

 

Figure 28 : NavMesh Baking 
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4.8 First Person View Workflow 

For First Person View I have used Unity Standard Assets first person controller. For 

First person view I have to make the models walkable. For that I have to bake 

NavMesh from the model. 

Go to Window > AI > Navigation 

Select the model parts that we want to bake as NavMesh. 

Set the NavMesh Agent height and radius. 

Bake The NavMesh. 

Now the FPS character can walk inside the model. 

Import the Satandard Assets [17] from Unity Asset Store [18]. 

From Standard Assets > Characters > First Person Controller > Prefabs > FPS Control 

Assign the FPS Control into Hierarchy 

As the NavMesh was baked before now the fps can walk inside of model. 

Create an Empty Game Object, Name it Camera Switcher. 

Assign a Script that will contain Camera Switching methods in Camera Switcher. 

Create a button and assign the Camera Switcher game object into the button. 

Now the Camera View Will be changed when button clicked. 
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Figure 29: FPS Controller 
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CHAPTER 5 

SOFTWARE’S & PLUGINS 

5.1AUTODESK AutoCAD 

 

 

Figure 30: Autodesk AutoCADLogo 

AutoCAD is a PC supported plan program utilized for 2D and 3D structure and 

drafting. AutoCAD is developed and marketed by Autodesk Inc. and was one of the 

first AutoCAD programs that could be executed on personal computers. 

 

Figure 31: This is the AutoCADinterface 
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PC helped plan programming gives you a chance to structure 2D and 3D illustrations 

and models, supplanting customary pencil-and-paper drafting to make diagrams with 

effectively adjusted electronic records. In the "AutoCAD 2009 and AutoCAD LT 

2009 Bible," Ellen Finkelstein composes that the product's discharge in 1982 denoted 

the first run through a CAD program was intended for use on PCs rather than 

centralized servers.[6] 

History 

AutoCAD was gotten from a program that started in 1977, and after that discharged in 

1979[4] called Interact CAD, additionally alluded to in early Autodesk records as a 

Micro CAD, which was composed preceding Autodesk's arrangement via Autodesk 

fellow benefactor Michael Riddle. Autodesk is the maker of AutoCAD and in 

addition AutoCAD LT programming, a less expensive form with fewer capacities 

discharged in 1993. At first accessible for Windows-based PCs just, AutoCAD wound 

up perfect with Apple items when AutoCAD for Mac hit store retires in 2010. 

AutoCAD Uses 

Geographic data frameworks utilize AutoCAD programming to archive the forms of 

the land and situation of milestones. Transferring AutoCAD 3D documents into 

Autodesk Simulation programming enables specialists to make mechanical 

reenactments of plans for pressure examination and testing for obstruction between 

parts. AutoCAD illustrations likewise can progress toward becoming movements that 

give virtual voyages through an arranged building or deliver showings of how an item 

shows up when gathered. You can even fare AutoCAD documents to 3D printing 

administrations that utilization printers containing tar to make plastic parts or models 

of bigger plans. 

Version history 

The local record arrangement of AutoCAD is .dwg. This and, to a lesser degree, its 

trade record design DXF, have progressed toward becoming true, if restrictive, norms 

for CAD information interoperability, especially for 2D drawing exchange AutoCAD 

has included help for. dwf, an organization created and advanced via Autodesk, for 

distributing CAD information. Autodesk's logo and, individually, AutoCAD symbols 

have changed for a few forms as the years progressed. 
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Student versions 

AutoCAD is authorized, for nothing, to understudies, teachers, and instructive 

foundations, with a three-year sustainable permit accessible. The understudy variant 

of AutoCAD is practically indistinguishable to the full business adaptation, with one 

special case: DWG records made or altered by an understudy rendition have an 

interior piece signal set At the point when such a DWG document is printed by any 

form of AutoCAD more established than AutoCAD 2014 SP1, the yield incorporates 

a plot stamp/standard on every one of the four sides. Items made in the Student 

Version can't be utilized for business utilize. Understudy Version objects "taint" a 

business adaptation DWG document on the off chance that they are foreign made in 

renditions more seasoned than AutoCAD 2015. 

 

5.2 Autodesk 3DS MAX 

 

 

Figure 32: Autodesk 3DS Max 

 

Autodesk 3ds Max 

Autodesk 3ds Max, in the past 3D Studio and 3D Studio Max, is an expert 3D PC 

designs program for making 3D activity’s, models, recreations and pictures. It is made 

and conveyed by means of Autodesk Media and Entertainment [19]. It has showing 

capacities and versatile module designing and can be used on the Microsoft Windows. 

It is every now and again utilized by computer game engineers, numerous TV ad 

studios and design representation studios. It is additionally utilized for motion picture 

impacts and film pre-representation. For its displaying and liveliness devices, the 



 

37 

©Daffodil International University 

most recent version of 3ds Max additionally includes shaders, unique recreation, 

molecule frameworks, radiosity is a utilization of the limited component strategy to 

unraveling the rendering condition for scenes with surfaces that reflect light 

diffusely). Typical guide creation and rendering, worldwide brightening, an adaptable 

UI, new symbols, and its own scripting dialect. 

Version 

3Ds Max has lots of versions. But we are knowing this kind of version: 

Table 3:Auto desk 3DS Max Version 

Version Codename Year Operating system 
Hardware 

platform 

Autodesk 3ds 

Max 2014 
Tekken 2013 Windows 7  

x64  

Autodesk 3ds 

Max 2015 
Elwood 2014 Windows 7 and Windows 8 

Autodesk 3ds 

Max 2016 
Phoenix 2015 

Windows 7, Windows 

8 and Windows 8.1 

Autodesk 3ds 

Max 2017 
Kirin 2016 

Windows 7, Windows 

8, Windows 8.1 and Windows 10 

Autodesk 3ds 

Max 2018 
Imoogi 2017 

Autodesk 3ds 

Max 2019 
Neptune 2018 

 

https://en.wikipedia.org/wiki/Windows_7
https://en.wikipedia.org/wiki/X64
https://en.wikipedia.org/wiki/Windows_7
https://en.wikipedia.org/wiki/Windows_8
https://en.wikipedia.org/wiki/Windows_7
https://en.wikipedia.org/wiki/Windows_8
https://en.wikipedia.org/wiki/Windows_8
https://en.wikipedia.org/wiki/Windows_8.1
https://en.wikipedia.org/wiki/Windows_7
https://en.wikipedia.org/wiki/Windows_8
https://en.wikipedia.org/wiki/Windows_8
https://en.wikipedia.org/wiki/Windows_8.1
https://en.wikipedia.org/wiki/Windows_10
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Figure 33: The is the Autodesk 3ds MAX interface 

Modeling techniques 

Polygon modeling 

NURBS (Non-Uniform Rational B-Splines) 

Surface tool/editable patch object 

Polygon demonstrating is more typical with diversion plan than some other displaying 

strategy as the simple particular command over individual polygons takes into 

account outrageous advancement. 

An option in contrast to polygons, it gives a smoothed-out surface that dispenses with 

the straight edges of a polygon display. NURBS is a scientifically correct portrayal of 

freestyle surfaces like those utilized for vehicle bodies and ship structures, which can 

be actually replicated at any goals at whatever point required. With NURBS, a smooth 

circle can be made with just a single face. 

The surface instrument was initially an outsider module; however, Kinetix gained and 

incorporated this component since variant 3.0. The surface apparatus is for making 

normal 3ds Max splines and after that applying a modifier called "surface." This 

modifier makes a surface from every three or four vertices in a network. 
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Project Workflow 

Each venture is unique, however, there are by and large advances that apply to almost 

every model you make with 3ds Max. Once you've introduced 3ds Max, begin the 

program by double-tapping its work area alternate way.  

Note: You can likewise begin 3ds Max from the Start menu or utilize some other 

standard Windows strategy. On the off chance that you begin 3ds Max from a 

Command Prompt window or a group record, you can include order line switches. 3ds 

Max is a "lone report application," which implies you can tackle only a solitary scene 

at some random minute. You can run numerous occurrences of 3ds Max and open an 

alternate scene in each example, however doing as such requires a considerable 

measure of memory. 

Topics in this section 

Planning Ahead 

Modeling 

Lights and Cameras 

Animating Characters 

General Animation 

Rendering for Final Results 

How far you prepare is dependent upon you. Be that as it may, it can realize how 3ds 

Max shows models. To make a model, you can begin with an assortment of 3D 

geometric natives. Materials control the presence of the surfaces of articles. You make 

lights with different properties to enlighten your scene. Characters make enthusiasm, 

connecting with one another or with articles in the scene. You can vitalize protests 

and in addition characters. Rendering adds shading and shading to your scene 
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5.3 UNITY 3D 

 

 

Figure 34 : Unity3d Logo 

 

 

 

Figure 35: This area is your vital component to the beginning with Unity3d 

Unity (game engine) As of 2018, the engine has been extended to support 27 

platforms. The motor can be utilized to make both three-dimensional and two-

dimensional amusements and additionally reenactments for its numerous stages. 

Unity is a cross-stage diversion motor created by Unity Technologies, previously 

reported and discharged in June 2005 at Apple Inc.’s. Worldwide Developers 

Conference as an OS X-elite amusement motor. Starting in 2018, the motor has been 

reached out to help 27 platforms. The motor can be utilized to make both three-

dimensional and two-dimensional amusements and also reenactments for its 
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numerous stages. A few noteworthy adaptations of Unity have been discharged since 

its dispatch, with the most recent stable variant being Unity 2019.1.2, discharged on 

May 10, 2019. 

Overview 

Unity enables clients to make amusements in both 2D and 3D, and the motor offers an 

essential scripting API in C#, for both the Unity proofreader as modules, and 

recreations themselves, and also simplified usefulness. Before C# being the essential 

programming dialect utilized for the motor, it recently upheld Boo, which was 

expelled in the Unity 5 discharge, and a variant of JavaScript called Unity Script, 

which was deployed in August 2017 after the arrival of Unity 2017.1 

The motor has bolstered for the accompanying illustrations APIs: Direct3D on 

Windows and Xbox One; OpenGL on Linux, Mac OS, and Windows; OpenGL ES on 

Android and iOS; WebGL. Also, Unity underpins the low-level APIs Metal on iOS 

and macOS and Vulkan on Android, Linux, and Windows, and also Direct3D 12 on 

Windows and Xbox One.  

Inside 2D amusements, Unity permits the importation of sprites and a progressed 2D 

world renderer. For 3D diversions, Unity permits detail of surface pressure, mipmaps, 

and goals settings for every stage that the amusement motor supports, and offers help 

for knock mapping, reflection mapping, parallax mapping, screen space including 

hindrance (SSAO), dynamic shadows using shadow maps, render-to-surface, and full-

screen post-planning impacts. 

Since around 2016 Unity likewise offers cloud-based administrations to designers, 

these are by and by Unity Ads, Unity Analytics, Unity Certification, Unity Cloud 

Build, Unity Every play, Unity IAP, Unity Multiplayer, Unity Performance 

Reporting, Unity Hub and Unity Collaborate. 

VR overview 

Solidarity VR gives you a chance to target computer-generated reality gadgets 

straightforwardly from Unity, with no outer modules in undertakings. It gives a base 

API and list of capabilities with similarity for different gadgets. It has been intended 

to give forward similarity to future gadgets and programming.  



 

42 

©Daffodil International University 

Solidarity XR API has been invigorated to reflect the broader umbrella term "XR" yet 

a critical piece of the documentation right currently still uses the articulation "VR". 

The XR API surface is irrelevant by design, anyway will reach out as XR continues 

creating.  

By utilizing the local VR bolster in Unity, you gain:  

• Stable variants of each VR gadget  

• A single API interface to communicate with various VR gadgets  

• A clean venture organizer with no outer module  

for every gadget  

• The capacity to incorporate and switch between various gadgets in your applications  

• Increased execution (Lower-level Unity motor improvements are workable for local 

gadgets). 

Empowering Unity VR Support 

To empower local VR to bolster for your diversion assembles and the Editor, open the 

Player Settings  

(Menu: Edit > Project Settings > Player)  

Select XR Settings and check the Virtual Reality Supported checkbox. Set this for 

each frame target. Enabling PC created reality to reinforce in an autonomous frame 

does not moreover engage the assistance for Android (and the different way). 

Utilize the Virtual Reality SDKs list showed underneath the checkbox to include and 

expel VR gadgets for each forming target. The request of the rundown is the request 

that Unity attempts to empower VR gadgets at runtime. The main gadget that instates 

legitimately is the one empowered. This rundown arrange is the equivalent in the 

constructed player. 
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Figure 36: XR settings 

Built applications: Choosing a startup device 

we created application in states and engages contraptions in indistinct demand from 

the Virtual Reality SDKs list in XR Settings [20] (see Enabling VR Support, above). 

Contraptions not present in the once-over at develop time are not open in the last 

shape. Contraption None is proportionate to a non-VR application (that is, a common 

Unity application) and can be changed to in the midst of runtime without fusing it in 

the summary; the uncommon case to this is None. 

Counting None as a gadget in the rundown enables you to default to a non-VR 

application before endeavoring a VR gadget's introduction. On the off chance that you 

put None at the highest priority on the rundown, the application begins with VR 

debilitated. At that point, you would then be able to empower and incapacitate VR 

gadgets that are available in your rundown through content utilizing XR.XR Settings. 

Load Device by Name. In the event that introduction of the gadget you endeavor to 

change to falls flat, Unity handicaps VR with that gadget still set as the dynamic VR 

gadget. When you switch gadgets or empower XR, the constructed application 

endeavors to instate once more.  

The order line contention used to dispatch a particular gadget is - vrmode 

DEVICETYPE where DEVICETYPE is one of the names from the upheld XR 

bolstered gadgets list. 

What happens when VR is enabled 

VR is empowered in Unity; a couple of things happen consequently: 
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Automatic rendering to a head-mounted display 

All Cameras in your Scene can render specifically to the head-mounted showcase 

(HMD). View and Projection grids are naturally changed in accordance with record 

for head following, positional following and field of view. It is conceivable to 

handicap rendering to the HMD utilizing the Camera part's stereo Target Eye 

property. On the other hand, you can set the Camera to render to a Render Texture 

utilizing the Target Texture property. 

Utilize the stereo Target Eye property to set the Camera to just render a particular eye 

to the HMD. This is helpful for embellishments, for example, an expert marksman 

scope or stereoscopic recordings. To accomplish this, add two Cameras to the Scene: 

one focusing on the left eye, the other focusing on the correct eye. Set layer covers to 

design what is sent to each eye. 

Understanding the camera 

The Camera Transform is superseded with the head-followed present. To move or 

pivot the Camera, join it as an offspring of another Game Object. This influences it 

with the goal that all to change changes to the parent of the Camera influence the 

Camera itself. This likewise applies to move or pivoting the camera utilizing a 

content. 

 

Figure 37: Hierarchy 

Equipment and programming proposals for VR advancement in Unity 

Accomplishing an edge rate like your objective HMD is fundamental for a decent VR 

encounter. This must match the revive rate of the showcase utilized in the HMD. On 

the off chance that the casing rate dips under the HMD's invigorate rate, it is 

especially perceptible and frequently prompts queasiness for the player. 
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Programming 

Windows: Windows 7, 8, 8.1, and Windows 10 are largely good.  

Android: Android OS KitKat4.4 or higher. 

Graphics card drivers: Make beyond any doubt your drivers are up and coming. Each 

gadget is staying aware of the most up to date drivers, so more established drivers 

may not be upheld. 

Device runtime requirements 

Each VR gadget necessitates that you have suitable runtime introduced on your 

machine. For instance, to create and run Oculus rift [21] inside Unity, you need the 

Oculus runtime (otherwise called Oculus Home) introduced on your machine. For 

HTC Vive [22], you need Steam and SteamVR [23] introduced. Contingent upon 

what variant of Unity you are utilizing, the runtime adaptations for every particular 

gadget that is bolstered by Unity may vary. You can discover runtime forms in the 

discharge notes of each major and minor Unity discharge. With some form refreshes, 

past runtime renditions are never again bolstered. This implies local Unity VR bolster 

does not work with prior runtime variants, but rather keeps on working with new 

runtime renditions.  

Solidarity local VR bolster does not peruse modules from inside your task's envelope, 

so including prior variants of the module with local help will come up short on the off 

chance that you have VR bolster empowered. On the off chance that you wish to 

utilize a prior rendition with an arrival of Unity that never again underpins that form, 

incapacitate Native VR Support (go to XR Settings and uncheck Virtual Reality 

Supported). You would then be able to get to the module like some other outsider 

module. See the area above on Enabling Unity VR Support for more subtle elements. 

Vuforia 

Vuforia [24] is a cross-stage Augmented Reality (AR) and Mixed Reality application 

advancement stage, with hearty following and execution on an assortment of 

equipment. Solidarity's joining of Vuforia enables you to make vision applications 

and diversions for Android and iOS utilizing an intuitive creating work process. A 
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Vuforia AR+VR tests bundle is accessible on the Unity Asset Store., with a few 

helpful models exhibiting the most imperative highlights of the stage. 

Marker-based tracking 

In AR or MR, markers are pictures or protests enrolled with the application which go 

about as data triggers in your application. At the point when your gadget's camera 

perceives these markers, in reality, this triggers the showcase of virtual substance over 

the world position of the marker in the camera sees. The marker-based following can 

utilize a wide range of marker types, including QR codes, physical intelligent 

markers, Image Targets, and 2D labels. The least difficult and most basic sort of 

marker in diversion applications is an Image Target. 

 

Figure 38: Marker based tracking 

Image Targets 

Image Targets are a particular kind of marker utilized in the Marker-based following. 

They are pictures you physically enroll with the application and go about as triggers 

that show virtual substance. For Image Targets, utilize pictures containing particular 

shapes with complex blueprints. This makes it simpler for picture acknowledgment 

and following calculations to remember them. 

Markerless following 

Applications utilizing Marker less following are all the more general area based or 

position-based Augmented or Mixed Reality. This type of following depends on 

advancements, for example, GPS, accelerometer, spinner and more unpredictable 

picture handling calculations, to put virtual items or data in the earth. The VR 

equipment and programming at that point regards these articles as though they are tied 

down or associated with particular true areas or items. 
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5.4 Adobe Photoshop 

 

Figure 39: Adobe Photoshop 

Photoshop was created in 1987 by the American siblings Thomas and John Knoll, 

who sold the dispersion permit to Adobe Systems Incorporated in 1988. It can alter 

and create raster pictures in numerous layers and backings covers, alpha compositing 

and a few shading models including RGB, CMYK, CIELAB, spot shading, and 

duotone. Notwithstanding raster illustrations, it has restricted capacities to alter or 

render content, vector designs (particularly through cut-out way), 3D designs and 

video.  

 

Figure 40: The is the adobe Photoshop interface 
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We are working Photoshop CC 2015 was developed on June 15, 2015, In this version 

was lots of function and very user-friendly, some new feature was - 

Artboards 

Adobe Stock marketplace 

Design Space (Preview) offers a designated mode for websites and mobile apps 

designers 

Camera Raw as a filter 

Some Layer styles can now be added up to 10 instances 

Redesign image export feature 

Adobe Camera Raw 9.1 

Linked files in CC Libraries 

Real-time healing previews. 

File Format 

Photoshop records have default document augmentation asPSD, which stands for 

"Photoshop Document." A PSD record stores a picture with help for most imaging 

choices accessible in Photoshop. These incorporate layers with veils, 

straightforwardness, content, alpha channels and spot hues, cutting ways, and duotone 

settings. This is rather than numerous other record groups (e.g., .JPG or .GIF) that 

confine substance to give streamlined, unsurprising usefulness. A PSD document has 

a most extreme tallness and width of 30,000 pixels, and a length point of confinement 

of two gigabytes.  

As far as possible was obviously picked subjectively by Adobe, not founded on PC 

math imperatives (it isn't near an intensity of two, as is 30,000) however for simplicity 

of programming testing. PSD and PSB groups are recorded. Due to Photoshop's fame, 

PSD documents are broadly utilized and upheld to some degree by most contending 

programming. The .PSD record configuration can be sent out to and from Adobe's 

different applications like Adobe Illustrator, Adobe Premiere Pro, and After Effects. 
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Photoshop tools 

After stacking Photoshop, a sidebar with an assortment of devices with numerous 

pictures altering capacities appears to one side of the screen. These devices normally 

fall under the classes of illustration; painting; estimating and route; determination; 

composting; and retouching. 

5.5Adobe Illustrator 

 

Figure 41: Adobe Illustrator 

Adobe Illustrator [25] is a vector designs proofreader created and promoted by Adobe 

Systems. Initially intended for the Apple Macintosh. 

 

Figure 42: The is the adobe illustrator interface 
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Version CC 

Alongside Creative Cloud, Illustrator CC was discharged. This form was the first to 

be just sold in a membership-based administration demonstrate, in accordance with 

the other programming in the once called Creative Suite. As a component of Creative 

Cloud, this rendition acquired upgrades that subject, for example, shading, text style 

and program settings matching up, sparing records to the cloud, and reconciliation 

with Balance and different highlights, for example, another touch-perfect sort device, 

pictures in brushes, CSS extraction, and documents bundling. 

The most current test for -Illustrator is additionally one of Rob's most loved 

applications.  Like many Photoshop users, when first learning it- he was frustrated 

with the tools and the different way of working! However, when a fashioner figures 

out how mind-boggling Illustrator is that you get to really fabricate interminably 

scale-capable pictures without any preparation you'll be snared. 

Tools 

A sidebar that shows up at the left of the screen with an assortment of instruments to 

choose, make, and control items or fine arts in Illustrator. These apparatuses can be 

chosen as following: drawing, composing, painting, reshaping, cutting and cutting, 

imagery, moving and zooming, and graph. Some instruments have a little triangle at 

the base right of the tool stash symbol. A little triangle has the choice to see or grow 

some shrouded instruments by hold down the mouse catch on the triangle. 

A few models of fundamental apparatuses in artist are determination devices, 

paintbrush instruments, pen devices, pencil devices e.g. Determination instruments 

are utilized to the format, change, and sort out the work of art by choosing, situating, 

and stacking object precisely. In addition, choice apparatuses can gather, bolt or cover 

up, and measure objects. Paintbrush devices can be utilized to adjust the presence of 

the fine art. There are distinctive kinds of brushes: calligraphic, dissipate, 

workmanship, design, and bristle.  Pen devices make straight and bent lines for the 

fine art and they can add grapple focuses to ways and erase from ways. Pencil devices 

enable the client to draw and alter freehand lines. 
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5.6 Visual Studio 

 

Figure 43: Visual Studio 

 

Microsoft Visual Studio [26] is an incorporated improvement condition (IDE) from 

Microsoft. It is utilized to create PC programs, just as sites, web applications, web 

administrations and portable applications. Visual Studio utilizes Microsoft 

programming improvement stages, for example, Windows API, Windows Forms, 

Windows Presentation Foundation, Windows Store and Microsoft Silverlight. It can 

deliver both local code and oversaw code.  

Visual Studio incorporates a code supervisor supporting IntelliSense (the code fruition 

segment) just as code refactoring. The incorporated debugger works both as a source-

level debugger and a machine-level debugger. Other inherent instruments incorporate 

a code profiler, shapes creator for structure GUI applications, website specialist, class 

planner, and database pattern fashioner. It acknowledges modules that upgrade the 

usefulness at pretty much every dimension—including support for source control 

frameworks (like Subversion and Git) and including new toolsets like editors and 

visual planners for area explicit dialects or toolsets for different parts of the product 

advancement lifecycle (like the Team Foundation Server customer: Team Explorer).  

Visual Studio bolsters 36 diverse programming dialects and permits the code manager 

and debugger to help (to differing degrees) almost any programming language, gave a 

language-explicit administration exists. Worked in dialects incorporate C, C++, 

C++/CLI, Visual Basic .NET, C#, F#, JavaScript, TypeScript, XML, XSLT, HTML, 

and CSS. Backing for different dialects, for example, Python, Ruby, Node.js, and M 

among others is accessible by means of modules. Java (and J#) were bolstered 

previously.  
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The most essential release of Visual Studio, the Community version, is accessible for 

nothing out of pocket. 

 

Figure 44: Visual Studio Interface 

History 

The first version of visual studio was visual studio 97, Before that Visual Basic, 

Visual C++, Visual FoxPro and Visual SourceSafe was sold separately. 

 

Figure 45: Visual Studio version history 
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For my project I have use Visual Studio Community edition 2017. Unity supports 

Visual Studio since Unity 2017.01 Version deprecating Mono develop [27] as its 

Primary IDE. But Now Visual Studio is the primary IDE of Unity3D. 

5.7 Babylon JS 

 

 

Figure 46: Babylon JS 

 

Babylon.js [28] is a constant 3D motor utilizing a JavaScript library for showing 3D 

illustrations in an internet browser by means of HTML5. The source code is 

accessible on GitHub and disseminated under the Apache License 2.0. 

Babylon.js, conveyed to you by the people at Microsoft, is an open source JavaScript 

structure through which you can manufacture and render 3D diversions inside a 

program, with the assistance of WebGL and HTML5. While drawing a 

straightforward 3D object in crude WebGL expects you to manage a gigantic measure 

of JavaScript code, Babylon.js gives you a chance to do something very similar with a 

negligible measure of code and low dimension of multifaceted nature.  

Babylon.js can be expressed as "one more Three.js" because of its amazing highlights, 

which enable you to make nearly everything, running from completely intuitive 3D 

diversions to vivified logos, in your program. In spite of the fact that this JavaScript 

structure is right now on its beginning time, yet even it offers engineers a strong 

establishment for making highlight rich WebGL manifestations that can be utilized all 

over the place. Ideally, a great deal of new cool highlights will be included soon. 

 

 



 

54 

©Daffodil International University 

5.8 UniGLTF 

 

 

Figure 47 : UniGLTF 

 

glTF (GL Transmission Format) is a document group for 3D scenes and models 

utilizing the JSON [29] standard. It is depicted by its makers as the "JPEG of 3D." It 

is an API-impartial runtime resource conveyance design created by the Khronos 

Group [30] 3D Formats Working Group and declared at HTML5DevConf 2016. The 

goal is that glTF be a proficient, interoperable resource conveyance group that packs 

the measure of 3D scenes and limits runtime preparing by applications utilizing 

WebGL and different APIs. glTF additionally characterizes a typical distributing 

position for 3D content instruments and administrations. 

glTF 2.0 was initially begun as glTF 1.0.1 (and later glTF 1.1) in June 2016 as a bug 

fix discharge to take care of corner cases found while building up the glTF validator. 

Concurrently, force developed around a Physically-Based Rendering (PBR) materials 

[31] augmentation proposition by Fraunhofer. Given the enthusiasm for PBR and an 

API-nonpartisan configuration, the glTF 1.1 exertion was extended to move toward 

becoming glTF 2.0 to incorporate the accompanying new major features:  
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Features 

PBR materials dependent on a metallic-harshness shading model. A specular-polish 

shading model is accessible as an expansion. 

Scanty accessors and transform focuses for strategies, for example, facial activity. 

Advancing a refreshed form of the glTF 1.0 paired glTF augmentation deeply 

particular.  

Diagram changes and breaking changes for corner cases or execution, for example, 

supplanting top-level glTF object properties with clusters for quicker record-based 

access. 

History 

On October 19, 2015 the glTF (GL Transmission format) was announced. 

glTF 2.0 was published June 5, 2017 at the Web3D 2017 Conference. 
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CHAPTER 6 

Model Output 

 

Gathering all the output from this project, Describing all of them below: 

Main Menu 

Augmented Reality View 

Normal Unity view (Without AR) 

Virtual Reality View 

First Person View 

6.1 Main Menu 

When the application starts, first there will be the logo of unity then the logo of the 

title of this project “Realview”. After that the main menu will take place. In the main 

menu screen, there will be logo of the project and there will be the menus for the 

buildings. Currently there are 3 buildings in this project. So, there are 3 different 

building images on the menu. By clicking any of the menu first the program will take 

the users into AR Scene where the camera will be start working. 

 

Figure 48 : RealView Main Menu 
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6.2 Augmented Reality View 

From the main menu after clicking building image the AR Scene will be launched. 

After that the device camera will start working. When the user will place the camera 

on the tracker image, Exterior of the selected building will be shown on the screen. 

User can rotate the exterior of the building to have a 360-degree view of the full 

building. On the top side of the screen there is a menu bar to navigate the users.On the 

top right side there is a button called floor view. Clicking it the exterior model will 

change and the interior model will be shown on the screen. Where users can rotate, 

scale the model to see it from all angles. There is another button beside floor view 

which will take users to the normal unity view mode. 

 

Figure 49 : Augmented reality view exterior model 
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Figure 50 : Augmented reality view interior model 

6.3 Normal Unity View (Without AR) 

Sometimes the users can not have the tracker image along with them. For that reason, 

I also have given a normal unity view (Without AR). By clicking the normal unity 

view button, the normal unity screen will be launched and users can see the models 

without AR view. The Exterior view will be shown first then the interior view will be 

shown after clicking the floor view button. There are some buttons at the left side of 

the screen. They are called as navigation button for the screen. By clicking those 

buttons users can see specific part of the model they want. Like if any users want to 

see the kitchen specifically, when he/she clicks the kitchen view button the camera 

will be showing the kitchen specifically. 

 

Figure 51: Normal View Exterior (Without AR) 
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Figure 52 : Normal View interior (Without AR) 

6.4 Virtual Reality View 

If any users obtain a Virtual reality device and they want to experience the full virtual 

walkthrough then there is an option for them is called VR view. By clicking that the 

user will be taken to the virtual reality mode of the program in interior models. 

 

Figure 53 : Virtual Reality View 
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6.5 First person view 

If any users do not have any virtual reality device, then there is an option for them to 

experience the models in first person view. Where users can move around the interior 

model by touching the screen of their mobile device. 

 

Figure 54: First Person View (FPS) 
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CHAPTER 7 

PROBLEMS & SOLUTIONS BASED ON UX 

 

While developing this project I have encountered many types of problems based on 

user experience and have found solution on that. I will discuss some significant 

problems that I have faced and solutions that I have found into this project. 

Multi tracking model interaction 

AR to VR conversion 

Low Poly Model Extracting 

Specific Room Section view 

7.1 Multi tracking model interaction 

Firstly, I wanted to make individual AR scenes for individual models. Then I have 

realized that user may put the wrong tracker of have the wrong tracker. If user uses 

the wrong tracker for the wrong scene then ser will not get the building view and that 

will be a very bad user experience. That is why I used all the trackers into one AR 

scene that will contain all the models. If user puts any of the target images it will pop-

up the specific model that is assigned to that target. 

 

Figure 55 : Multi target images 
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After putting all the target images into one AR scene I found out that I can move into 

only one specific model view from the AR scene. Then I have added some codes into 

Vuforia [10] core scripts that has come to me from the Vuforia SDK (Software 

Development Kit). Then I could go into any tracker-based model that I wanted. 

 

Figure 56 : Vuforia core script tweaking 

 

Figure 57 : Setting data target from Vuforia to another view 
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7.2 AR to VR Conversion 

In unity when you activate virtual reality SDK, it will turn the whole application into 

virtual reality project and that was another biggest problem for me while I was 

developing this project. I found out the application I built for testing purpose it has 

changed into Virtual reality application. So, I removed the virtual reality scene and 

separated it to another scene. Then I wrote a script for Virtual reality that will only 

activate when the virtual reality button will be pressed and when user will want to exit 

the virtual reality mode the app will go back to normal 2d state.  

 

Figure 58 : VR to AR toggling method 

7.3 Low poly model extracting 

One of the biggest challenges was Extracting the models from 3ds Max to unity. 

During my research I found out some companies like Adobe, Sketchfab [32], 

Facebook [33] uses a method that converts the 3d models into JSON (JavaScript 

Object Notation) using glTF (GL Transmission Format) format. So, I researched 

about that and found plugins that will convert my 3d models into JSON format and I 

can import it into my Unity project. That was a very time-consuming process though 

but at the end of the day it was successful. 
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Figure 59 : Extracting model form 3Ds max using Babylon JS 

7.4 Specific room section view 

One day I was showing my project progress to my supervisor and while he was 

reviewing my beta application, he gave me a suggestion to make specific room view 

option. Because some user can ask for it. So, I created a dropdown using unity and 

pulled my main camera to specific room parts that I want to show the users. I 

transformed my main camera into specific positions to have a better look. 

 

Figure 60: Dropdown drawing room view 
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Figure 61 : Dropdown dining room view 

 

Figure 62 : Dropdown bedroom view 
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Figure 63 : Dropdown kitchen view 

Except for those I created model switching script to switch the models in from a 

single button. I have given the users accessibility to rotate and scale the model if 

he/she wants.  
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CHAPTER 8 

FUTURE UPDATES 

 

Now let’s talk about the future updates and functionalities that will be in this 

application.  

8.1 On Demand model download 

To reduce the core application size the future update of this application will contain a 

system that is called On Demand model download. By that user will get the core 

application and rest of the models will be in the server. When the application will start 

user will be prompt to ask if he/she wants to download the model. User can 

specifically download any model they want then they can view the model with image 

tracker or in normal AR mode as they want.  

8.2 Pipeline & Electric View 

Pipeline and Electrical wiring view are another type of view that can be used on 

architectural visualization. In future there will be option for viewing pipeline and 

wiring views in this application. 

 

 

 

 

 

 

 

 



 

68 

©Daffodil International University 

CHAPTER 9 

CONCLUSION 

 

Technology Evaluation as the project revolved around Autodesk 3ds Max and Unity it 

was necessary to learn. This created a large stress on the project initially which 

pushed it slightly behind schedule. This is to be expected with any new technology; 

however, talking on the REALVIEW project increased the risk with using new 

methods of exporting the models to unity. Creating models in 3ds max and Exporting 

them was a good learning experience. 

Representation of various cameras, edges, surfaces and lighting makes a moment 

reaction environment; this decreases the time required to design key components 

however increases the requirement for experimentation. It ought to likewise be 

noticed that the 3d yield is exceptionally great for engineers with no past involvement 

in such an amazing situation. 

Creating curved, rectangle, square model, Max seems a little out of its depth. Whilst it 

offers a coding environment to create animation it sometimes seems too heavy to 

handle even slightly complex tasks – especially making a model. 

What I have gained from this project: 

This project has enabled me to utilize new environments. Both environments are 

cutting edge and used in with my patients’ level, so it was nice to get a taste of what i 

could enter into when i graduate. It would be good if more modules used newer 

technologies as it creates new challenges and allows the output to look a lot better. I 

am genuinely proud of what I have accomplished in both modules. The “Augmented 

Reality (AR)” and” Virtual Reality (VR)” was something completely new to me. I 

have done a short course about “Augmented Reality (AR)” and “Virtual Reality 

(VR)”and its requirements expandable enough so that, I could challenge myself and 

produce a really nice-looking mobile application with the combination of Augmented 

and virtual reality along with first person and normal 3d model view mode. 
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